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Introduction

USB to RS-422 / RS-485 adapter provides an extra serial com port via USB connection and can be configured
to work with RS-422 / RS-485 peripherals such as POS and industrial controlled devices. The USB adapter
supports an easy serial port expansion and requires no IRQ, DMA, or I/O port resources.

The USB adapter features a full set of RS-422 / RS-485 data and control signals on its DB-9 or terminal block
changer. It supports data transfer rates of up to 3M baud. It receives full power via the host USB connection,
and provides power to the attached serial device without requiring an external power adapter.

System Requirements

»  Windows OS: 98SE / ME / 2000 / XP / Vista / 7 / 8 / 8.1; Windows server 2003 / 2008 / 2008R2 / 2012 /
2012R2 or higher

» WIinCEOS:VvV4.2~V7.0

» Mac0S:8.6/9.x/10.x

»  Linux OS : Kernel 1.5.0 or above

» The system is equipped with USB host controller

Features

® Fully Compliant with USB specification 1.1 and 2.0

® Allows up to 256 nodes on the bus

® +15kV HBM ESD protected

® Supports data transfer rates up to 3M baud.

® Supports remote wake-up and power-on-reset

® Changer adapter from DB-9F to 5 pins & 7 pins terminal block

Specification:

Model No. UTS-422X + DT422C
Chip FTDI
Data Transfer Rate up to 3M baud
Power Consumption 56mA
LED 3
Operating Temp. 0 ~40
Environment Storage Temp. -20 ~ 60
Humidity 0~80% RH, Non-condensing
USB Specification USB 1.1/2.0 compliant
Interface RS-422
Connector Host USB Type A Male
Device DB-9M / DB-9F to Terminal block
Power Mode Bus powered
Housing Plastic




Model No. UTS-485X + DT485C
Chip FTDI
Data Transfer Rates up to 3M baud
Power Consumption 56mA
LED 3

Operating Temp. 0 ~40
Environment Storage Temp. -20 ~60

Humidity 0~80% RH, Non-condensing
USB Specification USB 1.1/2.0 compliant
Interface RS-485
Connector Host USB Type A Male

Device DB-9M / DB-9F to Terminal Block
Power Mode Bus powered
Housing Plastic

LED light Indication

Power/Link--- unit is ready for use.
RX---Receive Data (Data is being sent from RS-422 or RS-485 device to USB port)

TX---Transmit Data (Data is being sent from USB port to RS-422 or RS-485 device).



Pin Assignment for UTS-422X & UTS-485X

DB-9 Male Pin Assignment ( RS-422 )
i Pin 3
ISI,'I>?+2 RX+

Pin 4
RX-

DB-9 Male Pin Assignment ( RS-485 )
Pinz  Fin3
A+

1200 Pin 8
UTS-422X UTS-485X
DB-9 Male ( Female ) Terminal Block Pin No. | DB-9 Male (Female ) | ___ Terminal Block
Pin No. Definition

Definition 1 B- A+
1 TX- TX+ 2 A+ B-
2 TX+ RX+ 3 Non GND
3 RX+ TX- 4 Non (B-)
7 RX- RXC 5 GND 120Q Shorted
g GND R GND 675 1200
2 120Q 1200 Shorted 8 Non
8 Non 9 Non
9 Non

DB-9 Female

st i

TX+ RX# TX-' RX- GND 120Q

DB-9 Female




Windows OS Installation Guide

Driver can be installed through Windows Update automatically (Internet connection needed)
The FTDI drivers that have passed the WHQL tests are available for download using Windows Update.

OS requirements: Windows 7/8/8.1 or later.

Please go below ways for easy installation.

1. You may plug the device into host computer. And then it will pop up ‘Installing device driver software’ from
the taskbar of the screen. (Fig. 1) Click and connect to the Windows Update.

2. It will check your computer OS and download the applicable driver at the Windows Update automatically.

;B Installing device driver software * *

Click here for status.

Fig. 1

3. The program goes ‘Searching Windows Update’ from ‘Driver Software Installation’. (Fig. 2)

Driver Software Installation

Installing device driver software

Generic USB Hub 10 e
USB <-» Serial i_) Searching Windows Update...

Obtaining device driver seftware from Windows Update might take a while,
Skip obtaining driver software from Windows Update

Fig. 2

4. When the applicable driver is detected, it will run ‘Installing device driver software’. (Fig. 3)

F
"_! Driver Software Installation

Installing device driver softwagg

USB <-» Serial | {_iSearching preconfigured driver folders... |

Fig. 3




5. Then it shows ‘USB Serial Port (COMB8) installed’. Click ‘Close’ and go next step. (Fig. 4)

A Driver Scftware Installation

Your device iz ready to use
LIZE Serial Converter of Ready ta use
USE Serisd Port (COMNSE) of Ready to use

Fig. 4

6. Check ‘Device Manager’ of Control Panel from the computer OS and there shows USB Serial Port (COM8)
under ‘Ports (COM & LPT)’; the other one shows USB Serial Converter under ‘Universal Serial Bus
controllers’. (Fig. 5) Congratulation! You have finished installing the USB to Serial device successfully.

ré Device Manager -'. E@Iﬂ
File Action View Help
e« @I E HE ] E RS

> ¥ Metwork adapters B

& i Portable Devices
4 75 Ports (COM & LPT)

= USB Serial Port (COME)

- ) Processors
> -8 Sound, video and game controllers

».gM System devices
a a Universal Serial Bus controllers
|| I . § Generic USE Hub
|| I § Generic USB Hub
----- a Generic USE Hu_b
----- i USE Root Hub
..... § USB Root Hub
..... § USE Root Hub
..... # USB Root Hub i
..... § USB Root Hub
..... § USE Root Hub

m

H oo a1l _1nca LoD s

Fig. 5

NOTE: It may occur when driver is not installed successfully, please check below steps.

1. There is busy on access databank of Microsoft's Support link. Please try again or install driver of CD-ROM
provided.

2. Check your internet if it is failed to access Microsoft’'s Support link.

3. Check your computer configuration if it is disabled on Windows Update wizard.

J Oriver Software Installation l

Device driver software was not successfully installed

Phease condult with your device man urer For assatande getting thet déw

LISE <o Serusl X M drvcer found

What can Lde o oy devies ded et ksl pregetly




Windows 98SE Installation Guide

If a device of the same type has been installed on your machine before and the drivers that are about to be
installed are different from those installed already, the original drivers need to be uninstalled. Please refer to
the uninstalling instruction.

Download the latest available drivers from the FTDI website and unzip them to a location on your PC.
Connect the device to a spare USB port on your PC. This will launch the Windows Add New Hardware Wizard.

Windows may display a message reading "Building driver database" at this point which may take a few
minutes to pass. Click "Next" to proceed with the installation.

Add New Hardware Wizard

Thiz wizard zearches for new drivers for

LISB <-» Serial Cable

& device driver iz a software pragram that makes a
hardware device wark,

¢ Hack

Catcel |

Select ‘Search for the best driver for your device’. (Recommended) as shown below and then click ‘Next’.

Add Hew Hardware Wizard

“whhat do you want wWindows to do’?

& Search for the best diver for wour device.
[Recommendead).

" Display a list of all the drivers in a specic
lozation, =0 vou can zelect the driver you want,

< Back I Mest » I Cancel




Check the box next to "Specify a location" and uncheck all others as shown below. Click "Browse" and locate
the driver files. Once the files have been located, click "Next" to proceed with the installation.

Add Hew Hardware Wizard

‘windows will search for new drivers in its diver databasze
ah yaur hard drive, and in any of the follawng zelected
lozationz. Click Mest to start the seanch.

™ Eoppy disk drives
[T CO-ROM drive
™ Microsoft Windows Update

v Specily a location:
|t =]
Browse... |

¢ Back I Mext I Cancel |

Windows may display a message reading "Building driver database" at this point which may take a few
minutes to pass. Once Windows has found the required files, click "Next" to install the device.

Add New Hardware Wizard

Winoows driver file seamch for the device:

LISE Serial Converter

“windows is now ready b install the best drver for this
device, Click Back to zelect a different driver, or click Mest
to cortinue,

Location of driver:

CAVEPDRIFIMTOIBUS.INF
=

< Back

Caricel |




If the driver being installed does not have Microsoft WHQL signature files (.CAT files), the wizard will request a
driver disk to attempt to find them. Click "OK" on the "Insert Disk" message box.

Insert Dizk E2

0 Pleaze inzert the diz< labeled 'FTOI USE Drivers Dizk'. and then click OF.

The following window will appear to assist in locating the file. To proceed with the installation without the .CAT
file, click "Skip File".

Insert Disk

The file ftdibuz. cat on FTO USE Drivers 0k,
é‘ Disk canmot be found.

Cancel

Ingert FTDI USE Drivers Dizk in the selected
drive, and click OF.

Skip File

Details. .

LCiooy filez fromm:

UAES)

CHEP Dirivers j Browse. ..

If the driver being installed is Microsoft WHQL certified, then the .CAT files will be located with the other driver
files and should be installed automatically.

Windows should then display a message indicating that the installation of the serial converter driver was
successful. The COM port emulation driver must now be installed. Click "Finish" to complete the installation of
the serial converter and proceed to the COM port emulation driver.

Add Mew Hardware Wizard

@ USE Serial Converter

Windows has finished installing the software that your new
hardwmare device reguires.

T inish Y Cancel

< Back




Under Windows 98SE, the COM port emulation driver will be automatically installed from the same location as
the serial converter driver. However, if the driver is not WHQL certified as explained above for the serial
converter driver, the wizard will ask for the location of .CAT files. Click "OK" on the "Insert Disk" message box.

3¢

Insert Disk

0 Pleaze insert the dis« labeled 'FTOI USB Crivers Disk', and then click OF.

The following window will appear to assist in locating the file. To proceed with the installation without the .CAT
file, click "Skip File".

Inzert Disk

[risk cannot be found,

’ T he file 'ftdiport.cat' on FTD LISE Drivers 0K

Cancel
|rzert FTDH USE Drivers Dizk in the selected
drive. and click OF.

Skip File

Details....

LCopy files from;

PEE ELR

CWEP Drivers j Browsze. .

If the driver being installed is Microsoft WHQL certified, then the .CAT files will be located with the other driver
files and should be installed automatically.

Open the Device Manager (located in "Control Panel\System" then select the ""Device Manger" tab) and select
"View devices by type". The device appears as an additional COM port with the label "USB Serial Port".

Syetem Propertiez EIE

Generd  Device Manager tHardﬂaneF'rnﬁImI Parfamancs |

& Visw dewices by tyoe ™ Vigw devices by connection

*iﬁ Keyboad :]
*@ Modem

B Monibons

0| ) Mouss

I

W r Mubl OCantroder

(- F9 Mebwork adapher:

=% Ports [COM & LPT]

- o Correrications Port [COM1]
~# PCI ECP/EPP Port ILPT1)

' POl Seiial Past [COM2)

_F USB Serial Part (COMS
-9 Syshem devices
i+ Urinezrzal Serisl Bus controllers
H

Universal Serisl Bus cortiollzrs

]

11

Propecties I Refreszh I Remave | Prnt... r




Please note:

1. For multiple-port converter, each port has to be installed with the driver individually, i.e. you have to repeat
this installation procedure 2 times (2-port converter) or 4 times (for 4-port converter).

2. If you have any difficulties with the drivers we provided in this CD, you may download the updated or
appropriate versions from FTDI Web site:

www.ftdichip.com/Drivers/VCP.htm, supported device “FT232BL(M)”.
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Uninstalling Instruction

To uninstall drivers, follow the instructions below:
Disconnect any devices that are attached to the PC.

Open the Add/Remove Programs utility located in "Control PanelNAdd/Remove Programs". Select "FTDI
USB-Serial Converter Drivers" from the list of installed programs.

Add/Bemove Programs Properties
Install /U ninstall I windows Setup I Startup Dizk I

% Ta hstall a new program fram a floppy disk or CD-ROM
=

drive, click Install
Install..

@ The following software can be automaticall removed by
j
-

‘Windows, To remove aprogram or to modily its inztalled
components, select it from the list and click
Add/Hemove.

Chineze [Traditionall Language Supy
iFTD USB-toSenal Converter Divers
aetRight

InstantCD /DD J
|nternet Explorer Q828750

Japanese Language Support

KeinelDriver

Key Drive 1.0
Karean Language Support ;I

Add/Bemove... |

ok | Cancel | depb |

Click the "Add/Remove" button. This will run the FTDI uninstaller program. Click "Continue" to run the
uninstaller or "Cancel" to exit.

FTDI Uninstaller v3.0 |

If your USB device iz connected, please unplug it now.__

Prezs Continue to uninztall the drivers, or Cancel to quit.

Cantinue |

11



When the uninstaller has finished removing the device from the system, the caption on the "Cancel" button will
change to "Finish". Click "Finish" to complete the process.

FTDI Uninstaller ¥3.0

[EGIITILE

12



Troubleshooting

1. Windows 98SE cannot find drivers for my device

This error can occur if the VID and PID programmed into the device EEPROM do not match those listed in the
INF files for the driver. The VID and PID programmed into the device EEPROM may be found by using the
USBView utility from the FTDI website. These can then be checked against the VID and PID entries in the
driver INF files. If they do not match, that driver cannot be installed the VID and PID entries in the driver INF
files. If they do not match, that driver cannot be installed for that device without either re-programming the
device EEPROM or modifying the list of VID and PID numbers in the INF files. Please note that only your own
company VID and PID or FTDI's VID (0x0403) and FTDI PID issued for use by your company should be used
in the EEPROM and INF/INI files.

2. Windows 98SE forces a reboot after installing a device

This problem can occur if an application is accessing a file while the New Hardware Wizard is trying to copy it.
This usually occurs with the FTD2XX.DLL file. If installing a D2XX device, selecting not to restart the computer
then unplugging and re-plugging the device may allow the device to function properly without restarting.
Restarting the machine will allow the device to work correctly.

3. Driver installation fails and Windows 98SE gives error code 10

Windows error code 10 indicates a hardware error or failed driver installation. This error may appear if a device
has insufficient power to operate correctly (e.g. plugged into a bus powered hub with other devices), or may
indicate a more serious hardware problem. Also, it may be indicative of USB root hub drivers being incorrectly
installed. Please refer to the example schematics on the FTDI website for standard device configurations. If
the error persists, please contact the FTDI support department.

4. Device hangs randomly during operation under Windows 98SE

This is not caused by the driver, but is a hardware compatibility problem. Some newer USB 2.0 hubs and host
controllers can be susceptible to noise and can cause random device failures. This can be overcome by fitting
47pF capacitors to ground on the USBDP and USBDM lines on the USB connector side of the 27W series
resistors.

5. Windows 98SE complains about missing .CAT files

Files with the .cat extension are signature files issued by Microsoft that indicate a device driver is WHQL
certified. If a driver is not certified, there will be no .cat files available. When installing drivers in Windows 98SE
or Windows ME, the user is prompted to locate the .cat files if the operating system cannot find them. If the
driver is not certified but you wish to install it anyway, the files may be skipped by clicking the "Skip" button.

6. Windows 98SE complains about missing ftccomms.vxd file

This can occur when the USB Composite driver has been installed if the user has not browsed to the location

of the driver files. If this message appears, do not skip it but browse to the driver file location. The wizard will
then be able to correctly install the device.

13



Windows 2000 Installation Guide

If a device of the same type has been installed on your machine before and the drivers that are about to be
installed are different from those installed already, the original drivers need to be uninstalled. Please refer to
the uninstalling instruction.

Download the latest available drivers from the FTDI web site and unzip them to a location on your PC.

Connect the device to a spare USB port on your PC. Once the composite driver has been installed the Found
New Hardware Wizard will launch. Click "Next" to proceed with the installation.

Found New Hardware Wizard

YWelcome to the Found New

:i?,\ Hardware Wizard

Thiz wizard helps pou inztzll 2 device driver for 2
hardware device.

To continue, click Mest.

+ Biack I Mext | Canicel i

Select "Search for a suitable driver for my device (recommended)" as shown below and then click "Next".

Found New Hardware Wizard B

Install Hardware Device Drivers o
&, device driver iz a software pragram that enables a hardware device to work with

an operating system,

Thiz wizard will cormplete the installation for this device:

@ USB ¢- Serial Cable

A device diiver iz a zoftware program that makes a hardware device work, Windows
reeds diver files for your nev device, To lozate diver files and complete the
installation click Mest,

what do you want the wizard bo do’?
¢ Search for a suitable driver for my device [recommended]

€ Display alist of the known drivers for this device so that | can choose a specific
driver

¢ Back I eut » I Cancel

14



Check the box next to "Specify a location" and uncheck all others as shown below. Clicking "Next" displays a
dialog box for you to enter to the location of the drivers.

Found New Hardware Wizard i

Locate Driver Files
Where do pou want Windows to zearch for driver fileg?

Search far driver files far the following hardware device:

@ LUSB <-» Serial Cable

The wizard zearches for suitable drivers in itz driver database on your computer and in
any of the fallowing optional search locatiors that you specify.

To start the zearch, click Next. [f you are searching on a floppy disk or CO-ROM dive,
inzert the floppy disk or CD before clicking Newxt.

Optional search locations
[ Floppy disk drives
[T CD-ROM drives
¥ Specify a location
[ Microsoft Windows Update

< Back I Meut » I Cancel

Found New Hardware Wizard x|
Inzert the manufacturer's inztallation dizk into the drive 0K |
g zelected, and then click OF.

Cancel

Copy manufacturer's files from;

C:ACDM 2.00.00 | | Browse.. |

15



Click "Browse" to display an open file dialog box.

Look in: |3 COM 2.00.00 x| « & e E-

- FTDIPORT.INF

Hi

]

@
)
My Docy

File name; IFTDIBUS.INF j Open I
j Cancel |

Files of type: I Setup Infarmation [ inf]

Locate the folder containing the latest drivers downloaded from the FTDI web site above and click "Open",
then click "OK". The PC auto selects the correct INF file, in this case FTDIBUS.INF.

Once Windows has found the required driver .INF file, click "Next" to proceed.

Found Mew Hardware Wizard i

Driver Files Search Results
The wizard has finished searching for driver files for pour hardware device.

The wizard found & driver for the following device:

@ LSE <> Serial Cable

windows found a driver for this device. To hstall the driver \indows found, click Mest.

L% c:hedm 2 00,00 dibus. inf

< Back I Mest » I Cancel

16



Windows should then display a message indicating that the installation was successful. Click "Finish" to
complete the installation for the serial converter driver for this port of the device. The COM port emulation
driver must be installed after this has completed.

Found New Hardware Wizard ol

Completing the Found New
Hardware Wizard

e USE Serial Converter

Windows has fintzhed instaling the software for this device.

To cloge this wizard, click Finigh.

< Hack I Finizh I [Came] |

By examining the Device Manager (located in "Control Panel\System" then select the "Hardware" tab and click

"Device Manger...") and viewing by connection ("View > Devices by connection"), the device appears as a
"USB Serial Converter" with an additional COM port with the label "USB Serial Port".

=10 x]
J beton yew || &= = [ (2 || 0
- Intel(R) B2601EE LPC Interface Controller - 24D0 I

=1 B Intel(R) 52801E8 PCI Bridge - 244E
i -HE Intel(R) PROJL00 YE Metwoek Connecion
B9 Realtek RTLE139/810x Family Fast Ethernet NIC
- B 1rtel(R) B2E01EE SMBus Cantroller - 240
. H-2 Intel(R) 82&01EE Likra ATA Storage Contiobers
| HE Intel(R) B2E01EE Lkra ATA Storage Controbers
.E! = Irtel(R) G2E01EE LISE Universal Host Cortroller - 2402
Intel{R) 52&01E6 LSE Universal Host Condroller - 2404
InteIfR} 8280158 IISE Univarsal Host Cordrolles - 2407

ﬁ? USB Serial Converber
'_y‘ USE Serial F‘nrl‘ [{ata ics]
=] mTOSL Condroller - 240E

LB (m) InteItR) 893656 Graph|cs Contraller

;‘ Intsl{R} 82865GYPEIF Processar to I Controler - 2570
. Realtek AC'ST Audio
- zyctem board
el Audio Codecs -
! - Legacy Audia Drivers
- Legary video Capture Devices

[ Legical Dsk Manager
i % Media Central Deviess

Please note:

1. For multiple-port converter, each port has to be installed with the driver individually, i.e. you have to repeat
this installation procedure 2 times (2-port converter) or 4 times (for 4-port converter).

2. If you have any difficulties with the drivers we provided in this CD, you may download the updated or
appropriate versions from FTDI Web site:

www.ftdichip.com/Drivers/VCP.htm, supported device “FT232BL(M)".

17



Uninstalling Instruction

When uninstalling devices from Windows 2000, it should always be done through the Add/Remove Programs
utility as this uses the FTDI driver uninstaller program to remove files and registry entries to leave a clean
system. Other methods may leave fragments of the driver that may interfere with future installations.

Disconnect any devices that are attached to the PC.

Open the Add/Remove Programs utility located in "Control Panel\Add/Remove Programs ".Select "FTDI USB
Serial Converter Drivers" from the list of installed programs.

5& Add/Remove Programs :lglﬁ!
| Sark by:EName ha [

Currently instaled programs;

19 FTDI USE Serlal Converler Drivers

From yor

Click the "Change/Remove" button. This will run the FTDI uninstaller program. Click "Continue" to run the
uninstaller or "Cancel" to exit.

FTDI Uninstaller ] i |

If your USB device is connected, please unplug it now ...

Press Continue to uninstall the drivers, or Cancel to quit.

When the uninstaller has finished removing the device from the system, the caption on the "Cancel" button will
change to "Finish". Click "Finish" to complete the process.

FTDI Uninstaller ] i |

Uninstalling YID_0403&FID_6010

Deleting registry entries ...
Deleting files ...

Press Finish tn exit.

EartirLe Firizh |

18



Troubleshooting

1. Windows 2000 cannot find drivers for my device

This error can occur if the VID and PID programmed into the device EEPROM do not match those listed in the
INF files for the driver. The VID and PID programmed into the device EEPROM may be found by using the
USBView utility from the FTDI web site. These can then be checked against the VID and PID entries in the
driver INF files. If they do not match, that driver cannot be installed for that device without either
re-programming the device EEPROM or modifying the list of VID and PID numbers in the INF files. Please
note that only your own company VID and PID or FTDI's VID (0x0403) and FTDI PID issued for use by your
company should be used in the EEPROM and INF/INI files.

2. Windows 2000 forces a reboot after installing a device

This problem can occur if an application is accessing a file while the New Hardware Wizard is trying to copy it.
This usually occurs with the FTD2XX.DLL file. Selecting not to restart the computer then unplugging and
re-plugging the device may allow the device to function properly without restarting. Restarting the machine will
allow the device to work correctly.

3. Driver installation fails and Windows 2000 gives error code 10

Windows error code 10 indicates a hardware error or failed driver installation. This error may appear if a device
has insufficient power to operate correctly (e.g. plugged into a bus powered hub with other devices), or may
indicate a more serious hardware problem. Also, it may be indicative of USB root hub drivers being incorrectly
installed. Please refer to the example schematics on the FTDI web site for standard device configurations.

4. The device hangs randomly during operation under Windows 2000

This is not caused by the driver, but is a hardware compatibility problem. Some newer USB 2.0 hubs and host
controllers can be susceptible to noise and can cause random device failures. This can be overcome by fitting
47pF capacitors to ground on the USBDP and USBDM lines on the USB connector side of the 27W series
resistors.
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Windows CE Installation Guide

Download the latest available drivers for the required processor model from the FTDI website and unzip them,
the critical files in the driver package are:

ftdi_ser.dll - the VCP driver file
FTDIPORT.inf - user changeable file to allow devices with custom VID and PID combinations to be installed
Copy all of the unzipped files to the \Windows directory on the PDA.

If the PDA requires a host adaptor (e.g. USB host cable, presentation pack or Compact Flash host card), make
sure that it is connected and installed before proceeding.

Connect the FTDI device to a host USB port on the PDA. This will provide a dialog box to direct Windows CE
to the driver files.

Type the full name of the VCP driver file into the dialog box as shown below. If the file name is incorrect, the
driver will not be found and the device will not function.

| Enter the name of tha device
= driver for this device. For

information, see the device

marufacturer's docurmentation,

123(1[2[3]4]5]6]7[8]0]0]-]|=]®
Tabjqwle[r|t][y[ulifo|p[[]]
cApla[s[d[f]afnj[k[1]:]"]
shitf z[x[c[v]b[n[m][,[. /]«
ctlai|* |\ | [4[t]e]=

-

The device installation is now complete. The installation may be verified using the test program available form
the Utilities page of the FTDI website.

Please note:

1. For multiple-port converter, each port has to be installed with the driver individually, i.e. you have to repeat
this installation procedure 2 times (2-port converter) or 4 times (for 4-port converter).

2. If you have any difficulties with the drivers we provided in this CD, you may download the updated or
appropriate versions from FTDI Web site:

www.ftdichip.com/Drivers/VCP.htm, supported device “FT232BL(M)”".
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Troubleshooting

1. "Unidentified USB Device" dialog is not displayed when device is connected for the first
time

If the "Unidentified USB Device" dialog is not displayed when the device is connected for the first time, it is
likely that the PDA does not have a USB host capability or that the host is not installed correctly. Many PDAs
require some form of adaptor (USB host cable, presentation pack or Compact Flash USB host card) to provide
the USB host capability that FTDI devices require.

2. "Error installing USB driver ftdi_d2xx.dll" message

The following installation error may be displayed for a number of reasons:

£ | unidentified USB D & #x 10:36

(¥ sunday, June 01, 2003
F=| Tap hereto set owner information

ok

Error installing USE driver
frodi_dZux

New Tools Accounts ﬂ '-_'g‘[ E|‘

The driver name has been misspelt. The ".dll" file extension may be required for some platforms. The required
driver files are not in the \Windows directory. The driver file is in the wrong binary format.
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3. "Error installing USB driver ftdi_ser.dll" message

The following installation error may be displayed for a number of reasons:

' Unidentified USB D < % 12:17

_.'_4%' a4
=)

() sunday, June 01, 2003
F=| Tap hereto set owner information

=] Naupcoming appointments
& |nidentified USB Device @

Error instaling USE driver
foli_ser di

New Tools Accounts Q % ﬂ|‘
The driver name has been miss pelt - The ".dII" file extension may be required for some platforms - The
required driver files are not in the \Windows directory - The driver file is in the wrong binary format
4. "Unidentified USB Device" appears each time the driver name is entered
This error can be caused when the VID and PID listed in the INF file does not match the VID and PID

combination programmed into the device. It can also be caused if the INF file has not been copied to the
\\Windows directory.

r; Unidentified USB D & = 10:38 v;}" |Unidentified USB D o % 12:04

(@ sunday, June 01, 2003 (@ sunday, June 01, 2003

Unidentified USB Device Unidentified USB Device

Enter the name of the davice

s Enter the name of the device
driver for this device. For

o driver for this device. For
vl information, see the device
S| manufacturer’s docurmentation,

F4(5|6 a|0|- 112|345
Tabjq|wle[r[t]y[u[ifo]p[[]] Tabjq|wle[r|t]y[ul[ifo[p[[]]
CAP|a|s|d|f|O]lh]ilk(N]:]" CAPla|s|d|f|a|lh|jlk|l]|;]"
shitt|z[%[clv[blnim ! chift|z (R [clv|bin|m|,|.|/]+
Ctilau * [\ ] (4[]« ctifai) * [\ ] [4]t]]-

£
; 8
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One way to check this is to use the Registry editor that comes with Embedded Visual C++ (or a suitable
registry editor on the Windows CE device itself) to check for the registry settings (Tools > Remote Registry
Editor). With ActiveSync running, connect to your device then look at the registry setting
KEY_LOCAL_MACHINE\Drivers\USB\LoadClients\

|_ Windows CE Hemote Registry Editor = = & ﬂi |

ey BR Mo clieconi oo -

b o o = N 5 5

£ 2 My Computer 2] | Harme

= F2) POCKET PO 2003 Devce B\ Defant) [T y———
= (] HREY _CLASARS
=1 | HEEY_CURRENT _LIEER
=H] HREY_LCTAL_MACHINE

+ _'| Comm

5 120 U
] ChenlDeneurs
7] FiDa_OEWECE st
5[] LnmiChents

#1 | ) Defaut
#2570
# ] Cefai
¥ ] Expioee
+-_] ExitModene
% -[2] MARDWRORE
1] Toerd
L
-_| Loader
12 Wt
*{ s
] Fabtarm
w1 el
(3 _| Securky
& L] Sareines
w7 ond
¥ L] SOFTHERE
o] Spakam
- 188
-

SPOCKET B 2003 Devics | FREY_LO AL HALHIRG Drrer s TS oad Sarke| LIET_29550]

£

In this case, the entry is 1027_24592, which corresponds to a VID of 0x0403 (1027) and a PID of 0x6010
(24592) device. If this is not the device to be installed, the message will recur.

To solve the problem, the INF files must be edited to accommodate the required VID and PID. For the D2XX
drivers, edit the bold red entries in the following line in the ftd2xx.inf file:

[FtdiHwW] "FTDI Dual device"=FTDI,USB\&VID_0403&PID_6010
For the VCP drivers, edit the bold red entries in the following line in the FTDIPORT.inf:

[FtdiHw] %VID_0403&PID_6010.DeviceDesc%=FtdiPort232,FTDIBUS\COMPORT&VID_0403&PID_6010
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5. Device can write but cannot read

If the hardware does not work correctly under Windows 2000 or Windows XP then the problem is most likely a
hardware issue. Windows CE is not very tolerant of noisy hardware, so even "good" designs for Windows 2000
and XP may experience problems with Windows CE.

Another issue that has arisen with Windows CE is that different host devices support different bulk transfer
sizes. One method to attempt to resolve this is to reduce In Transfer Size to 64. This is the smallest possible
transfer size and will have a severe effect on performance, but should resolve most other issues. Larger
values may be tried to improve performance.

If a USB host CF card is being used, it may help to set the Raton bit in the configuration settings.

6. Bytes missing or data corrupt

This can occur when a host driver fails to send vendor commands properly which can result in the device
running at a different Baud rate to the one intended. The Baud rate can be verified easily by transferring data
from PDA/target to HyperTerminal. Some host device drivers have been seen to lose packets of data which
would also cause this problem.

7. Driver isn't sending or receiving any data

Sending and receiving data can be tested with an application such as VCPTest. However, this will not highlight

problems due to incorrect Baud rates. To check for the wrong Baud rate being set, try to transfer data from the
PDA/target to and from HyperTerminal.
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Windows XP Installation Guide

1. Installing Via the Found New Hardware Wizard

If a device of the same type has been installed on your machine before and the drivers that are about to be
installed are different from those installed already, the original drivers need to be uninstalled. Please refer to
the Uninstalling instruction.

Download the latest available drivers from the FTDI web site and unzip them to a location on your PC.

If you are running Windows XP or Windows XP SP 1, temporarily disconnect your PC from the Internet. This
can be done by either removing the network cable from your PC or by disabling your network card by going to
the "Control Panel\Network and Dial Up Connections", right clicking on the appropriate connection and
selecting "Disable" from the menu. The connection can be re enabled after the installation is complete. This is
not necessary under Windows XP SP 2 if configured to ask before connecting to Windows Update. Windows
XP SP 2 can have the settings for Windows Update changed through "Control Panel\System" then select the
"Hardware" tab and click "Windows Update".

Connect the device to a spare USB port on your PC. If the device is based on the FT2232, the Microsoft
composite device driver is automatically loaded in the background. Once the composite driver has been
installed Windows Found New Hardware Wizard will launch. If there is no available Internet connection or
Windows XP SP 2 is configured to ask before connecting to Windows Update, the screen shown in Figure

2.1 is displayed. Select "No, not this time" from the options available and then click "Next" to proceed with the
installation. If there is an available Internet connection, Windows XP will silently connect to the Windows
Update website and install any suitable driver it finds for the device in preference to the driver manually
selected.
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l':e? Ko ral ez lima

Chek =t b porlinus
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Figure 2.1
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Select "Install from a list or specific location (Advanced)" as shown in Figure 2.2 below and then click "Next".

Select "Search for the best driver in these locations" and enter the file path in the combo box ("C:\CDM
2.02.04" in Figure 2.3 below) or browse to it by clicking the browse button. Once the file path has been entered
in the box, click next to proceed.
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Figure 2.3

If Windows XP is configured to warn when unsigned (non WHAQL certified) drivers are about to be installed, the
message dialogue shown in Figure 2.4 will be displayed unless installing a Microsoft WHQL certified driver.
Click on "Continue Anyway" to continue with the installation. If Windows XP is configured to ignore file
signature warnings, no message will appear.
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Figure 2.4
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The screen shown in Figure 2.5 will be displayed as Windows XP copies the required driver files.
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Figure 2.5

Windows should then display a message indicating that the installation was successful (Figure 2.6). Click
"Finish" to complete the installation for the first port of the device.

Fuumnd Hizer Haritbear: Wizaril

Completing the Found New
Hardware Wizard
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E LS8 Senial Corvenroy

Dk Firdshlo cogw e misen]

Figure 2.6

If the device is based on the FT2232, the Found New Hardware Wizard will continue by installing the USB
Serial Converter driver for the second port of the FT2232 device. The procedure for installing the second port
is identical to that for installing the first port from the first screen of the Found New Hardware Wizard. This is
done automatically if the driver is Microsoft WHQL certified. If the device is not based on the FT2232, the COM
port emulation driver is loaded as indicated in the following steps.

The Found New Hardware Wizard will launch automatically to install the COM port emulation drivers. As above,
select "No, not this time" From the options and click "Next" to proceed with the installation (Figure 2.7).
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Figure 2.7

Select "Install from a list or specific location (Advanced)" as shown in Figure 2.8 below and then click "Next".
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Figure 2.8

Select "Search for the best driver in these locations" and enter the file path in the combo box ("C:\CDM
2.02.04" in figure 2.9 below) or browse to it by clicking the browse button. Once the file path has been entered
in the box, click next to proceed.

Fuumd Hizer Haritbear: Wizaral

Pl chines ot sk anil inslallalson aplions

IEI' wancd b e bt divss i Dhess el s |

R TR TR S L O RN 1) THE R T o ] T

Llzg Fes chack bosses: Lelos o bed o esquancd be delaul] saach, vabach mcudes: ksl
pathe end removable meda The bect dive lourd =l be nelaled

_ | Snsch smmcreanls mevis Foope CO-AOM.
] Irchids thiz bocatan i e s=arch
|Zoeom 20z0a w| | Eposes |
1 Cort mmarch | il chooss e diver fo sl

Chugnsw Ihes oplu o sebee] e deacas v hom a ksl Weninse doss rol guaianlge thel
tha cifes: pod choose il e ths becl nach o wou hackas

[ oot [ Hwiz ][ Cowst |
Figure 2.9

28



If Windows XP is configured to warn when unsigned (non WHQL certified) drivers are about to be installed, the
message dialogue shown in Figure 2.10 will be displayed unless installing a Microsoft WHQL certified driver.
Click on "Continue Anyway" to continue with the installation. If Windows XP is configured to ignore file
signature warnings, no message will appear.
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Figure 2.10

The screen shown in Figure 2.11 will be displayed as Windows XP copies the required driver files.
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Windows should then display a message indicating that the installation was successful (Figure 2.12). Click
"Finish" to complete the installation for the first port of the device.
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Figure 2.12

If the device is based on the FT2232, the second port must also be installed. The procedure for installing the
second port is identical to that for installing the first port from the first screen of the Found New Hardware
Wizard for the USB Serial Port device. If the driver is Microsoft WHQL certified, this is done automatically.

Open the Device Manager (located in "Control Panel\System" then select the "Hardware" tab and click "Device
Manger") and select "View > Devices by Connection", the device appears as a "USB Serial Converter" with an
additional COM port with the label "USB Serial Port" (Figure 2.13). If the device is based on the FT2232, two
ports will be available from a composite USB device.
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Figure 2.13
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In the case of the FT2232, port A of the FT2232 will be installed as COMX and port B will be installed as
COMX+1 where COMX is the first available COM port number.
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Figure 2.14

2. Installing Using DPInst

In the case of a Microsoft WHQL certified driver package, it is possible to preinstall the driver package using
the Microsoft Driver Install Frameworks (DIFx) tools. The simplest tool provided is the Driver Package Installer
(DPInst). When placed in the same directory as the INF files for the driver package, simply run DPInst.exe and
the certified driver package will be installed on the machine.

The current driver package supports 32bit and 64bit systems through common INF files. DPInst has separate
executables for 32bit and 64bit installation. This means that if a single solution is desired for 32bit and 64bit
systems, the developer must be able to detect which version of DPInst is required for the system the driver is
being installed on.

For more information on DPInst, see the FTDI Windows Driver Installation application note.
3. Installing From Windows Update

If a certified driver is available for the target operating system, it is possible to install the driver from the
Windows Update web site.

Directions to install the driver from Windows Update are very similar to those outlined in 2.1 Installing Via The
New Hardware Wizard, except that the “Yes, this time only” or “Yes, now and every time | connect a device”
option should be selected on the first screen of the wizard when asked if Windows Update should be checked
for a driver. If the wizard finds a matching driver on Windows Update, the driver will be automatically
downloaded and installed for the device.

Please note:

1. For multiple-port converter, each port has to be installed with the driver individually, i.e. you have to repeat
this installation procedure 2 times (2-port converter) or 4 times (for 4-port converter).

2. If you have any difficulties with the drivers we provided in this CD, you may download the updated or
appropriate versions from FTDI Web site:
www.ftdichip.com/Drivers/VCP.htm, supported device “FT232BL(M)".
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Uninstalling Instruction

Consequently, a new method for uninstalling has to be used. Devices can be removed using the Device
Manager by simply right clicking on the device and selecting "Uninstall". This will delete the associated registry
entries for that device only.

Under Windows XP, driver files and OEM INF and PNF files must be removed manually or by using a custom
application. OEM INF and PNF files are located in the Windows\Inf directory and can be identified by
searching for a VID and PID string matching the device installed e.g. VID_0403&PID _6001. Once the
matching OEM INF files are found (e.g. oem10.inf for FTDIBUS.INF and oem11.inf for FTDIPORT.INF), the
corresponding PNF files must also be removed (e.g. oem10.pnf and oem11.pnf). Driver files are located in the
Windows\System32 and Windows\System32\Drivers directories.

Some points to note about this uninstallation method:

In the case of FT2232 devices, a composite device is also installed. This can also be removed by right clicking
on the composite device in the Device Manager and selecting "Uninstall".

If the VCP driver has been installed, the COM port driver should be removed before the bus driver. If the bus is
removed first, the COM port will no longer appear in the Device Manager.

If the driver files are deleted while other installed devices still require them those devices will not work correctly.
This can be fixed by right clicking the device and selecting "Reinstall Driver" which will replace the missing
files.

If a device to be uninstalled is not connected to the PC, the device can still be removed by setting the device
manager to show phantom devices. This can also allow a virtual COM port to be uninstalled if the bus layer
has been removed first. Instructions on how to display phantom devices are given in the Advanced Driver
Options application note.
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Troubleshooting

1. Windows XP cannot find Drivers for My Device

This error can occur if the VID and PID programmed into the device EEPROM do not match those listed in the
INF files for the driver. The VID and PID programmed into the device EEPROM may be found by using the
USB View utility from the FTDI web site. These can then be checked against the VID and PID entries in the
driver INF files. If they do not match, that driver cannot be installed for that device without either re-
programming the device EEPROM or modifying the list of VID and PID numbers in the INF files.

Please note that only your own company VID and PID or FTDI's VID (0x0403) and FTDI PID issued for use by
your company should be used in the EEPROM and INF/INI files.

End customers should obtain modified drivers from the OEM of the device, and not necessarily edit the files
themselves.

2. Windows XP Forces a Reboot after Installing a Device

This problem can occur if an application is accessing a file while the New Hardware Wizard is trying to copy it.
This usually occurs with the FTD2XX.DLL file. Selecting not to restart the computer then unplugging and
re-plug the device may allow the device to function properly without restarting. Restarting the machine will
allow the device to work correctly.

3. Driver Installation Fails and Windows XP Gives Error Code 10

Windows error code 10 indicates a hardware error or failed driver installation. This error may appear if a device
has insufficient power to operate correctly (e.g. plugged into a bus powered hub with other devices), or may
indicate a more serious hardware problem. Also, it may be indicative of USB root hub drivers being incorrectly
installed.

Please refer to the example schematics on the FTDI web site for standard device configurations. If the error
persists, please contact the FTDI support department.

4. Windows XP Displays an Error And Then Terminates Installation

If the following screen is displayed with this message, Windows XP has been configured to block the
installation of any drivers that are not WHQL certified.

Hardware |Installation

6 The software vou are installing for this handware:
USE Serial Converter

haz not pazsed Windows Logo testing to venfi its compatibifity
with thes version of Windows. [Tell me whi thes teshing iz important]

Thiz hardware will ot be installed Contact your system
admirdstrator

Figure 4.1
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Two options are available to successfully install the device. Either a certified version of the driver can be
installed (if available) or the driver signing options can be changed to either warn or ignore to allow the
installation to complete.

To change the current driver signing setting, go to "Control Panel\System", click on the "Hardware" tab and
then click "Driver Signing". The desired signing option may then be selected.
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Windows VISTA (Win 7, Win 8, Win 8.1) Installation Guide

Connect the device to a spare USB port on your PC.

If there is an available Internet connection, Windows VISTA will silently connect to the Windows Update
website and install any suitable driver it finds for the device in preference to the driver manually selected. If no
suitable driver is automatically found then the following procedure should be followed.

- Found New Hardware %)

Windows needs to install driver software for your TTL232R
Tester

#® Locate and install driver software (recommended)

Windows will guide you threugh the process of installing driver software
for your device.

# Ask me again later

Windows will ask again the next time you plug in your device or log on.

i Don't show this message again for this device
Your device will not function until you install driver software,

When locate and install driver software (recommended)" is selected the following screen will appear. Note: the
text “TTL Tester” is replaced with the description of the customer hardware.

bt o Found Mew Hardware - TTLEIR Tester
Insert the disg that came with your TTL232R Tester

1 you karve the dise thai ceme with your dedce, inser i@ mew, Windmas will sctematically
search the disc for driver sehiware.

* [ don't have the disc. Show meé ather options

Select “I don’t have the disk. Show me other options” The next screen will appear.
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Windows couldn't find driver software for your device

* Check for a solution
‘Windows will check to see if there are sheps you can take to get your device
waorking,

< Browse my computer for driver software (advanced)
Lecate and install driver software manually.

" The next screen will appear.

Select "Browse my computer for diver software (advanced

Browse for driver software on your computer

Search for driver software in this location:

ENET

¥ Include subfolders
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Browse to the folder where the CDM driver has been stored (when uncompressed) and press “Next”

The example shown above uses a folder on the desktop.

The next screen will appear

=1

\nod 1 Found New Mardivare - TTLIZIR Tester

Installing driver software._.

This screen will automatically complete and then change to the one below:
i m—
_ =S
G | Found New Hardware - USB Serial Converter
The software for this device has been successfully installed
Windows has finished installing the driver software for this device:
USB Serial Converter
Close i

The bus layer of the driver is now installed.

After the driver is installed it is important to determine which COM port has been assigned to the device for
configuring the application that will use the device.

Open the Device Manager (located in "Control Panel\System" then select the "Hardware" tab and click "Device

Manager") and select "View > Devices by Connection", the device appears as a" USB Serial Converter" with
an additional COM port with the label "USB Serial Port".
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7 Device Manzger ==
File Action View Help
as|m @t

=il Computer

vy Disk drives

7 Wy, Display adapters

7 e DVOVCD-ROM drives

- Floppy disk drves

=l Flappy drive controllers

& L"ﬁ Human Interface Devices

=g IDE ATA/ATART contrallers

3§ [IEEE 1384 Bus host controllers

3 == Keyboards

7} l‘j IMice and other poinzing devices

=B Monitors

7L Metwork adapters

5 Wl Portable Devices

= T3 Pors (COM BLLPT]
Y= Communications Port [CORL)
"7 Prinker Port (LPT1)
Y31 UUSE Senal Port (COM3)

i B Processars

= % Sound, video and game controflers
%, High Definition Audio Device

=4 Storsge controllers

4l System dewices

e ] Universal Senal Bus controllers

This screen shows the device connected to COMS3.
Please note:

1. For multiple-port converter, each port has to be installed with the driver individually, i.e. you have to repeat
this installation procedure 2 times (2-port converter) or 4 times (for 4-port converter).

2. If you have any difficulties with the drivers we provided in this CD, you may download the updated or
appropriate versions from FTDI Web site:
www.ftdichip.com/Drivers/VCP.htm, supported device “FT232BL(M)”.
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Uninstalling Instruction

With the release of Microsoft Windows Vista, the FTDI uninstaller has been rendered unusable due to
Windows Resource Protection preventing the executable from deleting driver files and associated registry
values. Vista will only allow the system itself to modify files and registry values in these locations.

Consequently, a new method for uninstalling is required. Devices can be removed using the Device Manager
by simply right clicking on the mouse and selecting "Uninstall". This will delete the associated registry entries
for that device only. Vista provides an automatic method to delete driver

Confirm Device Uninstall [ ]

USE Senal Converter

=

Waming: You are sbout 1o urenstall this dewvice from your syestem .

|| Delete the driver software for ghis device

Windows 2000, XP and Server 2003 do not have this check box, so driver files and OEM INF and PNF files
must be removed manually or by using a custom application.

Some points to note about the new uninstallation method:
In the case of FT2232 devices, a composite device is also installed. This can also be removed by right clicking
and selecting "Uninstall". There is no option to delete the driver files when doing this as the driver for the

composite device is a native Windows driver.

If the VCP driver has been installed, the COM port driver should be uninstalled before the bus driver. If the bus
is removed first, the COM port will no longer appear in the Device Manager.

If the files are deleted while other installed devices still require them those devices will not work correctly. This
can be fixed by right clicking the device and selecting "Reinstall Driver" which will replace the missing files.

If a device to be uninstalled is not connected to the PC, the device can still be removed by setting the device

manager to show phantom devices. This also allows a virtual COM port to be uninstalled if the bus layer has
been removed first.
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Troubleshooting

1. Windows VISTA can not find drivers for my device

This error can occur if the VID and PID programmed into the device EEPROM do not match those listed in the
INF files for the driver. The VID and PID programmed into the device EEPROM may be found by using the
USB View utility from the FTDI web site. These can then be checked against the VID and PID entries in the
driver INF files. If they do not match, that driver cannot be installed for that device without either re-
programming the device EEPROM or modifying the list of VID and PID numbers in the INF files. Please note
that only your own company VID and PID or FTDI's VID (0x0403) and FTDI PID issued for use by the
customer should be used in the EEPROM and INF files.

End customers should obtain modified drivers from the OEM of the device, and not necessarily edit the files
themselves.

2. Devices not shown in Device Manager for uninstalling

Devices that have been installed on a system but are not currently available are referred to as "phantom
devices". These devices are not usually displayed in the device manager, but can be made to be displayed as
though they are attached. This allows device properties to be changed or devices to be uninstalled via Device
Manger even though the device is not physically connected to the PC.

To display phantom devices in Device Manager, a new system variable is required. Open "Control Panel >
System" then select the "Advanced" tab and click "Environment Variables". In the System Variables section
(NOT THE USER VARIABLES SECTION), click "New..." to display the following window:

-

Edit Systern Variable (=2
Variable name: Dewviagr_Show_MonPresent_Devices
Variable value: fl
[
[ ok || cancel |

Create a new System Variable called "DevMgr_Show_NonPresent_Devices" and set the value to 1, then click
OK.

Open the Device Manager ("Control Panel > System" then select the "Hardware" tab and click "Device

Manager...", or "Control Panel > Device Manger" in Vista) and select "View > Show Hidden Devices". Device
Manager will then show all hidden and phantom devices available on that PC as shaded.
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3. Windows Vista (Win 7, Win 8, Win 8.1) shows a warning that the driver is not certified

If the driver is not certified then a pop up window such as shown below will be displayed.

) Windows Security

@ Windows can’t verify the publisher of this driver software

«» Don't install this driver software

Yo should check vour manufacturer's website for updated driver software For vour
device,

<5 Install this driver software anyway
Only instaf driver software obtained from your manuFacturer's website or disc.
Unsigned software from other sources may hamm your computer or steal information.

ﬂ Sea detals

If you are certain of the source of the driver the warning can be ignored and you can continue installation by
selecting “Install this driver software anyway”.

4. Driver will not install on VISTA x64

VISTA x64 OS will only allow certified drivers to be installed. The certified driver supplied by FTDI will work with
VID 0403 and PID 6001 for FT232 and FT245 devices. It will also work with VID 0403 and PID 6010 for
FT2232 devices.

If you have a product where the manufacture has customized the driver but has not recertified it, then the
driver will not load. You should contact your vendor to determine if they will support VISTA x64.
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MAC OS X Installation Guide

Download the driver from the VCP Drivers section of the FTDI web site and save it to the hard disk. The driver
is now available in disk image (.dmg) format. Run the installer by double clicking on the
FTDIUSBSerialDriver.dmg icon.

r@ N Install FTDIUSBSerialDriver Kernel Extension ?

Welcome to the FTDIUSBSerialDriver Kernel Extension Installer

c | Welcome to the Mac OS5 X Installation Program. You will be
© Introduction guided through the steps necessary to install this software.

!
® Rexd Me

L] ‘:E:iu'-ﬁ"t, Destination

@ Installatjan Type

@ installing

.~ S

® Finish Up

" Go Back ([ Continue )

Click Continue to proceed with the installation and follow the instructions on screen.

When the installation is complete, reboot the computer.

ra e N Install FTDIUSBSerialDriver Kernel Extension 2
Install Software
a il;ltrodu:tion
© Read Me

© Select Destination

@ Installation Type

@ Installing | The software was successfully installed
|

A Finish Up ——

Click Restart to finish installing the software.

h

When the computer has rebooted, plug in the device. If the device is installed properly, you will see entries in
the /dev directory:
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/dev/cu.usbserial-xxxxxxxx
/devi/tty.usbserial-xxxxxxxx

Where xxxxxxxx is either the device's serial number or, for unserialized devices, a location string that depends
on which USB port your device is connected to. The Terminal application can be launched by selecting Go >
Applications > Utilities > Terminal. Type the following lines in the Terminal window to produce the file list:

cd /dev
Is-|

If you run the application System Preferences and select Network (Go > Applications > System Preferences >
Network), you should see the rtext "New Port Detected".

-

. = New Port Detected
=
| ‘ﬂ A new network port has been detected:
ushserial-1B22

Please verify thar it is configured correctly, then

press Apply Now to activate it

Click OK and select Network Port Configurations from the show list. The new port can be enabled from this
screen by checking the on box and clicking Apply Now.

®60 Network =N
Show All Di‘spia:,'s Sound Net-;mrk Startup Disk
Location: | Automatic 4
Show: | Network Port Configurations I'H
Check a configuration to make it active.
Drag configurations into the order you want to try them when
connecting to a network.
On | Port Configurations ] |
B usbserial-1822 p— =
™  Internal Modem (_New.o —9
@ Built-in Ethernet (' Edit '}
l-._beEe.._ = ]
(" Duplicate )
@
.5'.1 > S -
J;- Click the lock to prevent further changes. [‘_ Assist me... LS Apply Now _)
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At this point, it is possible to exit Network and use the device as a COM port. If you wish to set the device up a
modem for an Internet connection, select the new port from the show list to display the window below.

r P ]
860 Network =
« = A =2
Show All Displays Sound  MNetwork | Startup Disk

Location: = Automatic

Show: usbserial-1622

[PPP TCP/IP | Proxies Modem |

Service Provider: (Optionaly

Account Name:

Password:

Telephone Number:
Alternate Number: (Optional)

| Save password

Checking 1115 box allows all users of this computer 10
access this Internet account without entering a password.

( PPPOptions... ) ( Dial Now..

@

il -
Jfg Click the lock to prevent further changes. { Assistme... ] Apply Now

Entries for this screen are specific to the Internet account for each user. If you do not know the required details,
contact your Internet service provide

Please note:

1. For multiple-port converter, each port has to be installed with the driver individually, i.e. you have to repeat
this installation procedure 2 times (2-port converter) or 4 times (for 4-port converter).

2. If you have any difficulties with the drivers we provided in this CD, you may download the updated or
appropriate versions from FTDI Web site:

www.ftdichip.com/Drivers/VCP.htm, supported device “FT232BL(M)".
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Uninstalling instruction

To remove the drivers from Mac OS X, the user must be logged on as root. Root is a reserved username that
has the privileges required to access all files.

Start a Terminal session (Go > Applications > Utilities > Terminal) and enter the following commands at the
command prompt:

cd /System/Library/Extensions

rm -r FTDIUSBSerialDriver.kext

cd /Library/Receipts

rm -r FTDIUSBSerialDriver.kext

The driver will then be removed from the system.

To remove the port from the system, run the application System Preferences and select Network. Selecting
Network Port Configurations from the Show menu will display the port as greyed out. Select the uninstalled
port and click Delete. Confirm the deletion to remove the port.

E —
een Network =
o E .Q ‘*ﬂ'% i 2
ey V¥ b= s B—J
Show All Displays Sound MNetwork Startup Disk
Location: | Automatic ﬂ
Show: Network Port C-:;nﬁgurations K ?-]

Check a configuration to make it active.
Drag configurations into the order you want to try them when
connecting to a network.

On | Port Configurations

Eridi=18Ld —

Ef Internal Modem ' New
E‘ Built-in Ethernet ,i Edit
| Delete... ]
@
0., —
J¥  Click the lock to prevent further changes. { Assistme... ) Apply Noy
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Troubleshooting
1. How do | know what my device ID is?

Launch the System Profiler utility, or Apple System Profiler for earlier versions of OS X. This can be accessed
by going to the Finder and selecting Applications from the Go menu, then open the Utilities folder. Select USB
under Hardware in the pane to the left and then select the appropriate device from the USB Device Tree. In the
screen shot below (from OS 10.3), the device has a device ID given by:

Vendor Name: FTDI
Product ID: 24577 ($6001)

A Vendor Name of FTDI is equivalent to a Vendor ID of 1027 ($0403).

0686 system Profile R
Andy's eMac 10/01/2005 08:37
Contents USE Device Tree
¥ Hardware USE Bus
Mirnory ¥ USE Bus
PCHAGP Cards ¥ Hub in Apple Extended USB Keyboard
ATA LUSHE <-> Setlal
SCS) Apple Optical USE Mouse
LsB Mpple Exterded USE Keyboard
FireWire USE Bus
AirPart Card UZE High-Speed Bus
Modems
¥ Softwane

Applicatians
Extensions
Metwark

Logs & Wendor Name: FIDI
Speed: Up 1o 12 Mhb/sec

USE <-> Serial:

Product 10 24577 (38001)
Fus Pawer ima): 100

If the device does not work after installing the driver, it is likely to be because the PID is not supported by the
driver. If this is the case, contact FTDI Support with the PID that needs to be added to the driver. If the VID is
not 0x0403, it is likely that the device is not an FTDI device and we cannot support it.
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2. The device does not appear in the /dev directory or the text "New Port Detected" is not
displayed in System Preferences-Network

FTDI USBSeria Driver does not support your device ID (VID and PID). Disable the EEPROM so that the
device reverts to its default device ID, then replug. To get support for your device ID built into FTDI USBSerial
Driver, contact FTDI quoting your device ID and a description of your device.

3. The device cannot be accessed even though the device ID is Supported in FTDI USB Serial
Driver

An ownership or permissions problem is preventing the system from making the device accessible. Check that
the driver is owned by root and wheel. The most common symptom is the group for FTDI USBSerial Driver is
not wheel. To change the group, login as root and perform the following script in a Terminal window (Go >
Applications > Utilities > Terminal):

cd /system/library/extensions

chgrp -R wheel FTDIUSBSerialDriver.kext

Reboot for the change to take effect.
4. How do | open a Terminal window?

A Terminal window can be started by selecting Go > Applications > Utilities > Terminal .The terminal window is
equivalent to a DOS prompt in Windows.
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Regulatory Compliance

Disclaimer
Information in this document is subject to change without notice. The manufacturer does not make any representations or

warranties (implied or otherwise) regarding the accuracy and completeness of this document and shall in no event be
liable for any loss of profit or any other commercial damage, including but not limited to special, incidental, consequential,

or other damages.
No part of this document may be reproduced or transmitted in any form by any means, electronic or mechanical, including

photocopying, recording or information recording and retrieval systems without the express written permission of the

manufacturer.
All brand names and product names used in this document are trademarks, or registered trademarks of their respective

holders.

CE/FCC & Recycling Information

CE Certification

This equipment complies with the requirements relating to Electromagnetic Compatibility Standards
EN55022/EN55024 and the further Standards cited therein. It must be used with shielded cables only.

It has been manufactured under the scope of RoHS compliance.

FCC Certification
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 of the FCC
Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation.
You are cautioned that changes or modification not expressly approved by the party responsible for compliance could void your
authority to operate the equipment.
This device complies with part 15 of the FCC Rules.
Operation is subject to the following two conditions:
1. This device may not cause harmful interference, and
2. This device must accept any interference received, including interference that may cause undesired operation

WEEE (Waste of Electrical and Electronic Equipment),
=== Recycling of Electronic Products

In 2006 the European Union introduced regulations (WEEE) for the collection and recycling of all waste electrical and electronic
equipment. It is no longer allowable to simply throw away electrical and electronic equipment. Instead, these products must

enter the recycling process.
Each individual EU member state has implemented the WEEE regulations into national law in slightly different ways. Please

follow your national law when you want to dispose of any electrical or electronic products. More details can be obtained from
your national WEEE recycling agency.

CEFE
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